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Welcome, ladies and gentlemen. I'm Rosemarie Bartlett with the Pacific
Northwest National Laboratory, and I'd like to welcome you to today's webcast,
COMcheck Basics, brought to you by the U.S. Department of Energy's Building

Energy Codes Program. At this time, all participants are in a listen-only mode.

Before we begin the webcast, we will conduct a polling session. We have one
polling question for you today. To answer the question, you will need to press
the numbers on your touchtone phone. Please wait for the entire question to be
read before responding. There will be a brief 10 to 15 second period of silence
after the question has been asked so that the results can be compiled. Please

remain on the line.

The question is: How many attendees are at your location viewing the webcast
together? Please use the appropriate number on your phone to represent the
number of viewers at your site. For example, press one for one viewer, two for
two viewers, and so on. Please press nine to represent nine or more viewers.
Once again, the question is: How many attendees are at your location viewing
the webcast together? Please use the appropriate number on your phone to
represent the number of viewers at your site. Please answer now by using your
touchtone phone. Please remain on the line during the silence while the results

are compiled. Thank you. This concludes the polling session.
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A couple of logistical announcements before we begin. You may ask a question
at any time during the webcast today by using the Question pane on your
computer. Questions will not be answered via the computer, will be answered
live by the presenters as time allows at the end of the presentation. For those of
you wanting continuing education credit for the event today, a link will be
provided at the end of the webcast. AIA members should write down the link and
go to that link and provide us with their names and AIA membership numbers,
and we will submit the information to AIA for their credit. In addition, anyone
wanting a certificate of completion to self-report to a professional organization

should write down the link to go and generate and print one.

Pam Cole and | will be presenting today. I'm going to begin with a short
presentation on the basics of using COMcheck, then Pam will provide the
software demonstration. At the end of the software demonstration, we'll address
any questions that have come in. Since the webcast is COMcheck Basics, |
thought we'd start at the beginning and show you where you can actually access
COMcheck. That's from the Building Energy Codes Program website at
energycodes.gov. The center section of the screen here has COMcheck
products in the middle. There are three products that I'll talk about just briefly,
COMcheck, COMcheck-Web, and COMcheck Package Generator. First, let's
start with COMcheck. If you click on the COMcheck Link on energycodes.gov, it'll
actually take you to what we refer as COMcheck Desktop. COMcheck Desktop is
available either as a Windows version or a MAC version, and we refer it to as the
Desktop version because you literally download it to your Desktop. Also
available from energycodes.gov is our Web-based version of COMcheck,
COMcheck-Web. Now it has the same basic functionality of our Desktop version

with a few differences because it is an online tool. We also have COMcheck
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Package Generator, which is a Web-based application that allows you to
generate your own code compliant insulation and window packages rather than
following the predefined prescriptive packages from the code. Not going to talk
much about COMcheck Package Generator today. I'm going to focus actually on

COMcheck Desktop, and that's what Pam will be demoing later.

First, let's talk about commercial building compliance. There are three basic
building systems that you have to show compliance for a commercial building.
The building envelope, lighting systems, and the mechanical system. Depending
on what code or standard you have to show compliance to in your jurisdiction,
there are various compliance options available to you. There's typically some
kind of a prescriptive option where there's also predefined prescriptive levels; and
if you meet those levels and can demonstrate that, then you can show
compliance that way. There's usually tradeoff option, which is what COMcheck
implements, and then there's some kind of total building performance.
COMcheck, as | mentioned, implements the tradeoff option so it allows you to
show compliance for the envelope, lighting, and mechanical systems. However,
each major building system must comply on its own. You cannot do tradeoffs
across building systems. If you wanted to do that, that actually is the total
building performance and it would require a software package other than

COMcheck.

This is COMcheck Basics today that we'll be presenting, so | wanted to list a
couple other training opportunities for you if you want more information. On
energycodes.gov, we have a couple self-paced training tools that might be of
interest to you. COMcheck 101 follows a lot of the same information that we'll be

covering today, but includes a simple case study that you can work through in
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COMcheck to give you a little more practice. We also have COMcheck 201,
which actually is derived from questions we've received from our more advanced
COMcheck users over time, and we put answers to those questions in a self-
paced training tool. You can go through it in a half hour to an hour. So if you
have some interest in that, you can get to those from energycodes.gov. We also
have available on the website some COMcheck case studies. If you wanted a
little further practice with the software, you can use those case studies and get
some practice; or if you're in a position perhaps of doing some COMcheck

training for other folks, you can also make use of those case studies.

Now let's talk about some of the information you're going to need before you sit
down and actually run COMcheck on your project. You're going to want to have
some basic information about the builder and the project itself. You're going to
need your area takeoffs for your building components, for your exterior walls
areas, your floors, your roof ceiling areas, your window areas, door areas, and
things like that, so you might as well have those all done and ready to go. You'll
also need to provide the insulation R-values for your components, the
Fenestration U-factors, solar heat coefficients, and things like that. So have all
that information handy when you get started. For lighting compliance, you'll need
to have lighting fixture details, including fixture counts, the types of lighting
fixtures, et cetera. Heating and cooling system details and service water heating

details if you're going to be showing compliance for mechanical systems.

There are some main steps that you'll go through as you're completing
COMcheck for a project, and the first is one that I'll harp on a little bit this
morning, selecting the appropriate code. That's very important. Once you've

selected the appropriate code, you have some project information you'll enter.
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You'll go then to the Envelope screen and enter information about your building
components. If you're going on and showing compliance for lighting, you'll enter
interior lighting information. Under some codes, you'll have the option to show
compliance for exterior lighting as well. Then you'll enter mechanical equipment,
and hopefully everything's happy and you're building complies so you can view
and print the compliance reports. Then lastly, you're going to want to save your
data file and your report file, so we're going to talk about each of these in a little
bit of detail, and then Pam will go through these as well when she demos the

software.

So let's start off talking about picking the appropriate code. You need to make
sure that you've selected the appropriate code from the Code menu before you
start entering information into the software; otherwise if you get partway down the
road and you've entered some of your information and you suddenly realize you
never selected the correct code, you're going to have to start over because the
code selection dictates a lot of the entries in the software. Here's an example of
what the Code menu looks like for COMcheck. You'll see that there are several
versions of 90.1 and several versions of the IECC as well. We also have some
states listed in the Code menu and those are states that have adopted either
90.1 or the IECC and made some state-specific amendments to those codes and
requested from the Building Energy Codes Program to have those state-specific
changes implemented into COMcheck. So if your project is going to occur in one
of the states listed under the Code menu, you want to make sure to select that as
your code. If you're not sure what code to use, then the bottom of the list there's
an item called Info, Find Your Code; and if you have an active Internet
connection, you can click that link. That'll take you out to the energycodes.gov

website to our Status of State Codes and you can look up the appropriate code
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for your jurisdiction. When you exit the software, | just wanted you to be aware
that the software sets a couple defaults for you. The next time you launch the
software, it's going to remember the last code that you'd selected and the last
location that you had selected, and those will be defaults the next time you
launch the software. You do have an option to set some preferences in the
software as well, and you'll do that from the Edit menu. There are some general
preferences that you can set such as if you want your file saved in a particular
location each time, you can set that. You can also set the number of files to
show up under the File menu for Open Recent Files. You have the option to
enable or disable our Beyond Code Advisor, which is an advisor that can pop up
and give you more information on energy efficient building options so you can
have that enabled or not; your choice. We also have an option for you to go out
and periodically do a version update check, and you set that in Preferences and
what the software will do is when you have an Internet connection, it'll go out and
check our website to see if we have a later version of COMcheck then what you
are currently running on your Desktop. If we do, the software's just simply going
to notify you of that fact. The software will not automatically install the latest
version; it'll just notify that there's a later version available. There are also
preferences related to project such as if you're always going to be using the
same code and the same location for every project you enter in COMcheck, you
can set that as a Project Preference. There are some Envelope columns that
you can set to always appear on your Envelope screen, and you also can input
some information about the applicant. This information actually populates the
Project Details part of the Project screen; and if you're always going to have the
same applicant information for every project that you enter, it's best to go ahead
and set it as a preference, then you only have to type it in one time. There are

also a couple preferences related to the reports, related specifically to signatures;
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and if you email reports routinely to a particular building department, you can
also set that email as a preference, and then you don't have to type that

information every time you enter a new project.

So we've talked about selecting the appropriate code, setting your preferences, if
you want to do that, now we're going to talk about Project Information. First off is
Project Location, and this is important to the software because the project
location ties to our weather data files that are available for COMcheck. If your
location is not listed, then you want to consult your local building department as
to what location they want you to use. They might suggest you use COMcheck-
Web which actually always has available either a city list or a county list, or they
may have you select an alternate location for which we have a weather file; and if
you do that, you just want to make sure that that alternate location has weather
similar to your project location. You're going to select the Project Type. Now this
changes based on the code that's been selected. Under many codes, you have
two options - New Construction or Addition. But under Standard 90.1 1999 and
later versions, you actually have three options. - New Construction, Addition, or
Alterations. Lastly on the Project screen on the left side, you have Project
Details. This is optional information that relates to the title site permit, the
owner/agent designer contractor, and there's always a place for notes if you want
to make some notes either for yourself or for the code official, you can do that.
This information is optional, but it will print out on your report, so it's a good way
to keep track of your different reports that you may have. The other information
that's on the Project screen relates to Building Use. There's a list of Building Use
types, and again this is code dependent. We often get questions about: Why is
my particular building use type not in the list? If that's a question you have, then

my first recommendation is that you check what code you have selected in the
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Code menu because these lists come directly from the code. If you have the
proper code selected and you still don't see your type in the list, then you may
need to be talking to your local code official about options you'll have. Under
certain codes, you may also see on the Project screen, an area to enter your
exterior lighting applications, and I'll talk about that a little more later. Building
use types, as | said, they vary by code. Internal loads and lighting power
allowances are based on the user’'s designation of the building use and, as | said,
the options available to you on the Project screen for building use are based on

the code that you've selected in the Code Menu.

So we've talked about applicable code, making sure you have the right one
selected, set your preferences if you want to, enter your project information, and
now we're moving on to the Envelope screen where you're going to enter your
building components. The key thing when you're entering your building
components is to only enter those components that separate condition space
from unconditioned space or outside air. Those are the only components that the
Energy Code is concerned about. You only need to use those component
buttons that are applicable to your project. Some people feel the need to use
every component button, but you don't need to. Only use the ones that apply to
your project and only those that separate condition space from unconditioned
space or outside air. The software is actually setup to try to make it as simple for
you as possible, and one way you can do that is you can group like-components.
So if you have components of one type, let's say all your exterior walls have the
same construction characteristics, let's say they're all wood framed, 16-inch on
center with R-13 cavity insulation, you could add the square footage of all those
components together and insert only one row into the table. Now you don't have

to do it that way, it's your choice, but the software will allow you to do that. The
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assembly types that come up in the software for each building component are
based on the code you've selected. If the assembly types that are listed do not
describe the assembly type you'll be installing in your building, there is the option
to use the Other type in that list. A couple caveats associated with that. If you
choose one of the assembly types that's listed, the software is already
accounting for other pieces of the assembly such as air films, so you only enter
the R-value of the insulation to be installed. If you use Other, that is not the case
and you'll need to enter the overall U-factor for the entire assembly including air
films. If you do that, just be aware you're going to have to have some backup
documentation for the code official, maybe manufacturer’s literature or some kind
of documentation of the calculation you used to figure out that U-factor. When
you're entering the components on the Envelope screen, with one exception, all
the rest are going to be entered as gross area. The one exception is slab on
grade components. Those are entered as perimeter length and feet. All other
components are entered as gross area. So for example, with exterior walls,
you're going to include the area of the entire wall, including the windows and

doors because we're talking gross area.

Now with foundations, just a quick note: If you have a condition basement and
the basement walls are insulated, the floor above that space is not insulated,
you'll use the Basement button. You'll use the Floor button if the floor component
separates condition space from unconditioned space or outside air. | just
wanted to add a note about slabs. In COMcheck, you also have to note whether
the slab is heated or unheated. A heated slab, an example of that would be a
radiant slab, is one that designed as part of the space conditioning system for the
building. The reason you have to denote whether it's heated or not is because

heated slabs have higher insulation requirements than unheated slabs. You'l
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also have to give some information about the slab insulation that's used, it's

position and it's depth.

When you're on the Envelope screen, the entries can change based on the code
and/or the location that you've selected. | already mentioned the assembly types.
Under some codes, you may also have a component button that's called Interior
Wall, so | just wanted to mention that that is available under some codes, and
you can use that button to enter interior above grade walls that separate
conditioned space from unconditioned space. One example of that might be a
conditioned office space within an unconditioned warehouse. But again, that's
only available under certain codes; and if you have any questions about the use
of that button, | would direct you first to the software Help. There's some more

information in there.

You'll also have entries for projection factor, so | just wanted to talk about that
briefly and show you this graphic that's in the software. The projection factors,
the ratio of the distance to overhang projects from the window surface, that's A in
this diagram, to its height above the windowsill, and that's B in this diagram. So
the projection factor is A over B. Again, there's more information in the software
Help system. Lastly, | just wanted to mention that the software will allow you to
enter your building components with or without considering orientation. It's your
choice; but initially, the orientation option is going to be turned off. So if you want

to enter them by orientation, you're going to have to turn that option on.

A quick look at the Envelope Report: Pam will go into this in more detail, but |
just wanted to show that at the top of the report, you have basic project

information; Section 2 gives you a little more information about the project.
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There is some information in here related to the location that you didn't enter.
The user just enters the location and the report will spit out the climate zone, the
heating degree days, and the cooling degree days for that location as well.
Section 3 is where we start to get into the requirements, so it's some information
that you've provided about the components and then gives you more information

about the requirements.

So we've talked about selecting the applicable code, entering your project
information, entering your building components, and now we're going to talk
about Interior Lighting. There are mandatory requirements related to all the
building systems, and those mandatory requirements are included in the reports
in the Requirements' Checklist section of each of the reports. The thing to note
about interior lighting is what we're trying to do is calculate your total connected
power and see if that proposed wattage is going to be less than or equal to what
you were allowed based on the code you've selected and the building use types
you've selected under the Project screen; and if the proposed wattage is less
than or equal to that allowed wattage, then your interior lighting passes. When
you're entering your interior lighting, you're going to be entering things such as
the fixture types, including the ballasts, if that's applicable; the number of lamps
per fixture; the quantity that you have of that type, and the fixture input wattage.
The fixture input wattage is the electrical power input to the lamp and the ballast
combination. So | wanted to show you a partial screen capture of the Interior
Lighting screen. The LPDs, the Lighting Power Densities, your allowed wattage,
again, is based on the building use types you selected on the Project Screen,
and | wanted to show that when you're on the Interior Lighting screen, you'll see
your individual building uses that you had selected and the software will tell you

what you're allowed wattage is based on the LPDs for that building use. As you
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enter your fixtures under each building use type, the proposed wattage figure will

calculate for you.

Exemptions and allowances may also apply to your project, so how you'll get to
those is under the Options menu. You'll select exemptions and allowances which
will put in a new column on your Lighting screen for you. These again are based
on the code that you've selected. If you have exempt fixtures, put them into the
software to make sure that you have accounted for all the fixtures that will be
installed in your building for the code official, but mark them in the software as
Exempt. Exempted fixtures in the software are the power for those are omitted
from the proposed wattage, so that's how the software handles those. So, yes,
the power is exempt, but you want to make sure to include them in COMcheck

just so you have a complete picture of your lighting system for the code official.

Similarly if you have a lighting allowance that applies for particular fixtures in your
building, you'll want to make sure to denote those allowances, and the software
will then increase the allowed wattage for the building by that allowable amount.
So exempt fixtures, their wattage is omitted from the proposed wattage, not
included, and allowed wattage for building is increased by the allowances, and

Pam will show you that as well when she gets into the software demo.

A quick look at the Interior Lighting reports: You have mandatory requirements
that are listed over here in Section 3 and it's very important that whomever is
signing the report make sure that you've gone through and looked at those
requirements to note which ones are applicable for this project and make sure

that the building is going to comply with those because whomever signs the
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report is signing that the lighting does comply and that means that all those

mandatory requirements have also been met.

Moving on to Exterior Lighting: As | said, this is available in the codes, in certain
codes, depending on the code you selected, and the codes where it will show up
are Standard 90.1 2004 and 2007 and the 2006 IECC. Similarly to interior
lighting, there are some mandatory requirements related to your exterior lighting,
and those typically are related to controls and lamp efficacy, and they will also
print on the exterior lighting report. As with most things in the code, there are
some exemptions so you'll want to be aware of those; and if you have any
guestions, the software Help relates what all of those are. Very similar to Interior
Lighting, the process is to figure out your proposed connected lighting power and
calculate your exterior lighting power allowance based on the exterior
applications you entered on the Project screen; and if your total connected power

is less then that power allowance, then your exterior lighting will pass.

| wanted to caution folks, when you're entering exterior lighting applications to
just be aware to pay particular attention to the Units column because the units do
change based on the application type that you've entered. So for example, in the
first row here, we have a Drive-Up Window; and under Units, it says Windows
and the quantity is two. So that means we have two drive-up windows. If you
look at Item 3 here, the Parking Area, you'll see the Units says Square Footage
and the quantity is 15,000, so we have 15,000 square feet for the parking area.
So just be aware, it's just a caution as you're entering your quantities to make

sure that you're entering them properly.
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Exterior applications are either tradable or non-tradable, so let's talk tradable first.
Those are common applications where you can use any unused power
somewhere else in another tradable application. So for example, parking lot
lighting, if you don't use all of your allowance for that, you could trade it and use
some of it for canopy lighting. On the other hand, the non-tradable applications
are those that are less common and they usually have some kind of a security or
a safety relationship to them. So for example, a drive-up window is non-tradable
and if you don't use all of your allowance for that drive-up window, you can't use

the extra allowance somewhere else. It's not tradable.

Quick look at the Exterior Lighting Report. Again, we have project information up
at the top. We actually have our Calculation section; and you can't see all of it
here on this example, but Section 4 begins the Requirements' Checklist for these

exterior lighting fixtures.

So we've kind of worked our way through COMcheck now, we've talked about
the appropriate code being selected, project information being entered, talked
about entering our building components on the Envelope screen, worked through
interior and exterior lighting. Now let's talk about Mechanical. Mechanical works
a little bit differently than Envelope and Lighting. When you're looking at the
screens in the software in the bottom right corner, you'll see the Compliance
Field. There's a Compliance Field for Envelope; there's one for Interior Lighting;
and depending on the code, there may be one for Exterior Lighting as well, but
you don't see Compliance Field for Mechanical. So Mechanical just works
differently; and the way COMcheck is setup is that it's going to have you enter
some details about your HVAC system, your plant, and your water heating

system; and based on the code that you've selected and your location it's going
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to go through this huge list of requirements and basically filter through that huge
list from the code and filter out only the ones that are applicable for your location
for the systems that you've entered, so you'll end up with a different report than
what you see for Envelope and Lighting. You'll just have a long list of
requirements for which you'll need to make sure that you're complying to
demonstrate compliance, but you don't get plus or minus percentage like you do

for Envelope and Lighting.

When you're entering HVAC system information, that actually HYAC system term
actually refers to your secondary HVAC systems, so it's things like your controls,
your fans, radiators, coils, packaged HVAC equipment, not the primary system
components. Those are entered under Plant, and that would be things like your
boilers, chillers, your cooling towers, your pumps and things like that. Water
heating is actually handled as a series of checkboxes and you either select the
ones that actually apply. So by you selecting or deselecting certain checkboxes,
that dictates what requirements will end up printing out on your Requirements'
List for Mechanical. So as | said, the Mechanical Report looks different than the
Envelope and Lighting Reports; although, you do have project information at the
top, you get a regurgitation of the mechanical systems that you've entered in
Section 3 and then you start your list of requirements in Section 4. So again,
whomever is signing off on the Mechanical Compliance Report is signing that all

of those requirements have been met.

I've talked a little bit already about mandatory requirements and they must be
met by all buildings regardless of the compliance option that you're using to show
compliance. They are included in the compliance reports like I've talked about in

the Requirements' Checklist section. You also can view them from the software
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Help as well so - - and that software Help does vary by the code you've selected.

Just to give you an idea of what some of the mandatory requirements are like, for
example an Envelope, they relate to things such as air leakage, insulation
installation, building component certification, and things like that. Your lighting
mandatory requirements focus mostly on controls, like your interior lighting
controls, light reduction controls, and so forth. On the Mechanical side, most of
all the requirements are mandatory requirements, that's why the compliance is
handled differently for Mechanical, but they include things such as the system
controls, outdoor air ventilation, the deck construction and insulation

requirements, pipe insulation requirements, et cetera.

| never miss an opportunity to give a shameless plug for the software Help
system accessible from the Help menu in the software. If you have a question
when you're using the software, then | would recommend that your first stop
should be the Help system. There's a lot of information in there. It's basically the
complete users guide online available to you. One of the things | think has been
helpful for people in particular is when you're reading through on the Envelope
screen and trying to select the appropriate assembly type, if you don't understand
the differences among the assembly types, those are all described in the Help
system; and as | mentioned, it is code dependent. So depending what code
you've selected in the software, you'll get the correct Help version popup for that
code, so all of the information will be code-specific at that point. So please look

at the Help if you have any questions.

As you're working through the software, | wanted to just talk about some of the

screen operations and what you'll see going on in the screens. At the bottom of
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the screen, we have a couple of bars that are there to provide you information.
The first bar is the Compliance Bar, and this is obviously where you're going to
be looking to determine whether or not your envelope and your lighting are
actually complying or passing or not. We also have at the bottom of the screen
what we call the Status Bar; and if you click in any active cell on the screen, the
Status Bar will change and provide you information about what's supposed to be
entered in that cell. So it can be kind of helpful to look at as you're going through
entering your information if you're unclear about what needs to go in that cell,

look down at the Status Bar.

The software also makes use of colors and to put it simply: Red is bad. We don't
like to see red. Red usually indicates that there's information that's missing.
There's an error somewhere or worse case, you're failing compliance, so we
don't like to see red. If you think you should be seeing a compliance result and
you're not seeing a compliance result or perhaps you're seeing a message in the
status bar you don't understand, often times the best thing to do is to look at your
active screen and look for red text, that's usually what it's trying to tell you.
Green on the other hand is good. We like green. We hope to see green. That
indicates a passing condition. There are occasions where you actually may see
blue text on the screen, and that usually indicates that you haven't provided the
software enough information for it to actually render a compliance result for you,
so you need to go back and look at the screen and make sure that you've

entered everything that needs to be entered.

Lastly on the screen operations, we actually have a little menu that we call the
Context Menu. What this is if you right click in a particular cell on the screen,

you'll get this little menu that pops up, and this is for the Windows application.
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Depending on the row you're in, you'll get different options available to you in this
Context menu - Cut, Copy, Paste, Duplicate Row, Delete Row, Use Default.
Now the Use Default will actually allow you access to default values from the
code, however want to make sure that you use this with caution. For example, if
you're on a Window row and you do not know the U-factor for the window to be
installed and you want to use a default, you can select Use Default but beware
that these are very conservative values and chances are they're not going to help
you demonstrate compliance, more likely they're going to hurt you. So the best
bet is to actually enter the true values for the products that are going to be
installed. This Use Default option is actually available also on the Lighting
screen. If you don't know the fixture wattage, Use Default may be available for
your fixture. It's not available for all fixture types. But again, just be aware, it is a
default conservative value so you're better off if you can actually use the true

value.

We've gone through now, we've talked about selecting the appropriate code;
entering our projection information; our building components on the Envelope
screen; our lighting information, interior and maybe even exterior depending on
the code we've selected; and if life is happy and all is well and your building
complies, the next step is to deal with your files. There are two different files that
you actually want to save. You have a Data file, and that's your actual CCK file.
You'll do that under the File menu and select Save. It's always a good idea to
save your data file because you never know if you'll have to go back and make
changes to that file, perhaps resubmit later, so it's better to save your file rather
than have to recreate it. You also are going to want to save your Report file,
which is in PDF format. You do that by going to the File menu and choosing

Save Report. COMcheck has also been setup to allow you to actually exchange
18



ﬁ@/ COMcheck Basics

Building Energy Codes

files between COMcheck Desktop and COMcheck-Web. So for example, if
you've saved a project on your hard drive and you want to open that file in
COMcheck-Web. You can log into the Web version of the software and click on
the Load Project link. Conversely if you've saved a project in COMcheck-Web
and now you want to have it available to you on your Desktop, you can sign into
COMcheck-Web and click on Download and download it to your Desktop. One
of the advantages to that obviously is if it's on our servers and saved in
COMcheck-Web, then you actually have access to that file wherever you are if

you have Internet access, so a lot of people find that of value.

| wanted to end this part of the presentation by just covering a few of the most
common questions we've received over time about COMcheck. The first being
whether or not you could trade over compliance in Envelope for under
compliance in Lighting, vice versa. Basically the question relates to whether you
can do trade-offs among the building systems; and as | mentioned earlier, you
cannot do that. If you want to be able to trade off compliance from one building
system to another, you're going to have to use a total building performance tool,
not COMcheck. COMcheck requires that each building system comply on its

own so Envelope on its own, Lighting on its own, etcetera.

Another common question that we get is the difference between cavity insulation
and continuous insulation. Cavity insulation is that that's installed in the cavities
between framing members and all our values should be for the insulation only.
As | mentioned, the assembly types listed in the software already account for
things like air films, et cetera. So if you're using one of the assembly types from
the component list, then you just want to enter your cavity or continuous

insulation R-value. Continuous insulation is insulation that runs continuously
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over structural members and it's free of significant thermal bridging, so an
example of that would be rigid foam insulation. Now there are occasions where

you may have both so enter it as appropriate.

Lastly, we sometimes get tech support questions related to the version that
people have, and usually what'll happen is someone will send in an email and
say, "lI've... | just downloaded the software and | have the 2001 IECC version
and | need the 2006 IECC version," and really all that user needs to do is go up
under that ever popular Code menu and select the 2006. There's a default code
that will pop in the first time you launch it. So if you have that question, just again
refer back to that Code menu and make sure that you have the appropriate code

menu selected.

So with that, that ends my part of the presentation on COMcheck Basics, and I'm

going to turn it over to Pam for a COMcheck software demo.

Thanks, Rose. The software demo, we'll be demonstrating the actual Desktop
version, and I'm going to go ahead and open up that. The first thing that you
should see is the first time you open the software is a popup screen that actually
will ask you your Energy Code setting. You can turn this off if you don't want to
see it every time, but it's just a little teaser to make sure that you're on the right
code when you open up the program. I'm just going to go ahead and read this

little popup and then I'm going to hit Okay to remove that popup.

So let's talk a little bit about some of the shell of COMcheck and then we'll get
into playing around with some of the actual components and entering some. At

the very top is the Title Bar. This is where you'll see the Version number that
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Rose talked about. If you had an open file, it would have a file name and then
dot-cck. The dot-cck is the extension of all data files that are saved, and | don't
have a data file open so it'll always say Untitled for the first time that you open up
the program. Next on that Title Bar is the code. The code defaulted when |
opened up COMcheck is at 90.1 2004. This might not be the code when you
open up your software; and again if you've opened it up and you've chosen a
code and closed the software, then the next time you open that same code that
you chose the last time will be the defaulted code and will show up in that blue
Title Bar. The next down below the Title Bar is the Menu Bar and then there are
several drop down options in these Menu Bars. We'll go over those. The bar
below that is the Tool Bar. This is your Windows' functionality for your Cut,
Paste, Copy, and Print. Below the actual Tool Bar is your Project tabs. You
might not see all these Project tabs because this is code-driven. One of the ones
you probably might not see if you're on an older code would be the Exterior

Lighting tab.

So let's go back up to the File menu or the Menu Bar and let's go over some of
these menus. So if | click on File, in this dropdown list, | can open up a data file; |
can open up a recent one. | can save my data file, my project. | can view and
print, and | can save it as a report. Saving it as a report saves it as a PDF, not as
a dot-cck, and then that can be opened up in Adobe Reader; and then again, you
can actually email the report directly to the building department if you have that
option. The screen that will come up, it's going to ask you: Well what reports do
you want to email to that building department so you have the options to click off.
If you're not doing interior/exterior lighting for the project, you can click those off.
You can click off Mechanical and so forth. Then again, you do have the option

as it does create reports as a PDF. There is an option to create it as an RTF.
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We have more information on why we have this option out in our Resource
Center in the website under Resource Center at energycodes.gov. But this
functionality is for designers that want to create it as an RTF, that want to import
it into their CAD drawings and submit their CAD drawings electronically, so it's a

nice option for them that they can show their projects right on their drawings.

In the Edit menu, the dropdown, you will see that's grayed out is the Cut, Copy,
Paste, Delete, and Duplicate Rows. The reason why those are grayed out right
now, I'm not in an active cell anywhere entering information, so | don't have those

options available to me. I'll show them when we start entering some data.

But the Preferences, Preference option is kind of a nice feature. This is in our
newest or in our newer versions, and this allows designers that are doing multiple
projects every time that they can set preferences so they don't have to enter their
information every time they're starting a new project, so let's go over some of
these. You have four tabs, General, Project, Applicant, and Reports. In General,
you can dictate your file options or your path name of where you want to find
your files. You can turn off that Beyond Code Advisor, or you can leave it on.
That takes you out to additional information on energy efficiency opportunities
and buildings that you might want to look at, and then that Version Update. | can
actually change when | want to be notified or if | don't want to be notified at all
when there's a version update if I'm connected to the Internet. Over in the
Project tab, | can default for the code and location, the state and city to come up
every time | open up COMcheck, if | want to. If I'm dealing in multiple states, |
probably don't want to have a default here, and | would unclick. | don't want to
use the code location to show every time. The code will show up every time, but

you're going to have to change the city and state applicable to your project within
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the Project tab of COMcheck. On the Envelope portion, there are some other
features that are optional that | can enable that | want to show up in my columns
in my Envelope tab so | don't have to choose them to show up every time and
that would be orientation or comments. Maybe | have some specific information
on a wall assembly that | want to add more information to to show that on my
report for that plan reviewer so he doesn't question what I'm doing, and | can
enable that column. I'm not going to enable any of these right now, but let's go
down to Interior Lighting. On Interior Lighting, | can select to show on the Interior
Lighting folder my exemptions and allowances; and with that, I'll get an extra
column that will appear where if I'm doing some maybe some retail display, I've
got some decorative lighting, then | want to make sure I'm showing those
exemption allowances; and if | have a lot of that going on, | don't want to have
repeatedly in the software continually go up and click on that option and have it
come down into my grid. In here, it's going to do it every time | open up
COMcheck, so I'll just click on that one and say that | want that as a feature.
Let's go over to Applicant. Another nice feature with this is | don't want to type in
my owner and my designer every time | open COMcheck, so I'm just going to
enter my name here so that way every time | open COMcheck, this is one less
piece of information that | need to be entering and | can go right ahead and start
entering my Envelope and/or Lighting data. | can also come over to Reports and |
can customize the signature lines. | can customize for Envelope, Lighting, and
Mechanical or either/or. This is optional, but | could have the name title for who
that person is, customize on those reports, which makes it pretty nice; and then if
you into emailing reports, and you're dealing with the same building location, |
could enter their name, email, and my email address and then this will be as a
default preference that | don't have to enter again every time I'm going to go

email that report. So I've actually set a few preferences in here. | set a
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preference for the enabling the exemption and allowances; and in the applicant, |
set a preference for my first and last name to show up under the owner/agent,

and I'm going to go ahead and click Okay.

Pam.

Yes.

I'm going to interrupt you for a moment because | just wanted to let everybody
know that when Pam's demoing the software, on your own computer screens,
you should see some scroll bars. So if Pam is describing something on the
screen and you don't see it, then you can take control of your own screen and

scroll over or up and down as you need to to see what she's describing.

Okay. Thanks, Rose. | have now clicked Okay off the Preferences and it took me
back to the main screen. I'm in the Project screen of COMcheck. But when |
selected those preferences, | actually entered my name Owner/Agent. You don't
see it here. When you're dealing with preferences and you've actually modified
and enabled some or put some information in there, you need to refresh
COMcheck for that to show up. So I'll come up to my Too Bar and I'm going to
hit New with the little piece of paper that's right there. Hit New. | don't have a
project. | don't want to save anything to this. I'm going to say Save Changes -
No; and then again, now it's refreshed to a new project and down under
Owner/Agent you see my name. Now up... Now that we're down into the Project
tab, let's go back to the Menu Bar and let's go under View. Under View, you
have the options to click off your Tool Bar or Status Bar. | highly advise you don't

do that because you will be wanting to see those within your projects, and you
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have mandatory requirements. The mandatory requirements actually takes you
to the software help and that is based on the code that you've chosen and the
information that you've entered that it'll actually throw up to you what those
mandatory requirements are. With that, those mandatory requirements will also
show up on the Compliance reports. Under the Options dropdown, now all these
are grayed out because you can't click on these unless you're in the actual tab
where these would be applicable. The Comments, Description, which would be in
the Envelope, so if | was in the Envelope Tab, | could click on that, Orientation.
But you'll see the Interior Lighting one is checked because | checked it in
Preferences, so now every time I'm in the software, that will automatically be
checked; and then you have an Exterior Lighting. | have to be in the Exterior

Lighting tab to be able to make that an option.

Rose talked about Code Menu. There's several codes in this software. The one
that I'm on is the 90.1 2004. | highly suggest that when you start entering
information, you don't switch between codes because that can change a lot of
things as far as assembly components are not the same between these codes.
So if you've entered a whole bunch of information in your Envelope and you go to
switch the code, you're going to have to readjust a lot of the information more

than likely before it's going to calculate a compliance result for you.

The Help section is the Software Users Guide and you can search in the
Software Users Guide. There's definitions and so forth in there and then a little
information down below about COMcheck, what talks about the actual software

itself.
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Tool Bar is straightforward, and we'll play around with that when we're entering

information.

Now let's take a look at the Project tab. This is where you will enter your state
and city. Down under Project Type, you have the option for New Construction,
Addition, and Alterations. Alterations will not appear unless you're in the 90.1
Code Options. In the Other codes, that is not an option. So if you're dealing with
alterations, you need to confirm that you can choose 90.1 and show your
compliance with the applicable 90.1 Version. Semi-heated, I'm not going to get
into Semi-heated too much, but this is also code-driven and the requirements for
semi-heated buildings are different and can be shown when you're on 90.1
depending on the code. Then Project Details, | can click on the Edit Project
Details and then | have three more tabs that will appear. This is not preferences;
this is for the project I'm working on right now. So under Title Site and Permit, |
can start entering some information in here and it's going to appear on this
report. 1 can go over to Owner/Agent and the same thing again. It's already
showing that my name and last name is in here because | did that as a
preference. But if | wanted to again, | could actually change that to a different
name and it'll appear just on this one. But if | open up COMcheck again, you're
going to see the first and last name that I've entered as a preference. Designer
Contractor, same thing, your applicable information that you want to show on
your report - - Address, Location, Permit Number, and any notes that you might
have down below that you want to be a part of your Compliance Report as well

you can enter.

Over on the right-hand side is your building use type and again depending on

what code, you might not see space-by-space and you'd only have the choice to
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use Whole Building. But with the code that I'm now, I'm on - - | can click Off Area
Category and go over to Whole Building, but let's click on Area Category and let's
enter a couple spaces here. Again, this is very dependent upon the code that
you're on, so I'm just going to quickly enter Retail Space and give it a square
footage for my retail cells area. | can click on Add which will give me another
column and | can add another space to my area, and let's just say that it's
Parking Garage and I'll enter some more square footage for my parking garage.
Down below the Exterior Lighting area, if I'm not doing Exterior Lighting, optional,
then I'm not going to enter any information under the Exterior Lighting or any of
my applications for exterior. Again, this is code-driven. You might not see the
Exterior Lighting option on the Project tab at all depending on what code you're
on. Down at the very bottom of this screen that will appear on every tab that
you're in has your Compliance Index. So with this one, you'll see Envelope,
Interior Lighting, and you got the Exterior Lighting. TBD means really | haven't
done anything with this project. | don't have any information, so there's nothing
really to calculate, so they'll show up in blue. It's looking for information; it can't
start calculating to show me even a result for any of that. So when | start
entering, you'll see that it's going to start calculating if | have something that it
can calculate on if nothing's in red and so forth. Down at the very bottom is that
Status Bar that every time I'm doing something, it's going to give me a little note
to actually help me as far as what I'm doing that might here do this, do that, or
don't do this type of thing, so you want to look down there if you're stuck on

something to see if that will help you.

Lets' go over to the Envelope. On the Envelope tab, you will see some blue and
white buttons. These are your Assembly Components where you can start

building the Exterior Building Envelope of your conditioned space. You have
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Roof, Skylight, Exterior Wall, Interior, (This is code dependent.) Window, Door,
Basement, and Floor. Doesn't mean you're going to use all those components,
but each one of them has a dropdown list of Assembly Types. So as you're
looking at your building plans and you're starting to run your takeoffs, typically
you're going to have a roof area. You would click on that button, and if one of
those matches your Assembly Types, then you would choose it. So let's just go
ahead and say it's an Attic Roof with Still Joists. Once you've entered your
Assembly Type, you will come over to the Gross Area column and now you're
going to calculate from your takeoffs the square footage of that area. This is
not... As far as the square footage for a roof, it depends on where the insulation
is placed. If it's placed at the ceiling area and not the roof deck, then you're
calculating the square footage of the ceiling area, so this insulation is being
placed at the ceiling area and I'm going to total up the square footage and I'm

putting in 4,500 square feet.

Next information that you would enter is your Cavity and Continuous; and before
| do that, what you're seeing over in the column after Continuous is a U-factor
column, and there's already calculation there. Every time that you choose one of
the assemblies from any of these calculations that has a choice for you to
choose, it has an assumption already for the typical construction of that assembly
- Framing; Air Films; Gyp Board, if applicable, and it will calculate that U-factor.
But what it doesn't know is the square footage and what your insulating that

component to; and it will recalculate this U-factor based on those inputs.

Roof is a little bit tricky, and we get a lot of questions on it. If | have an added
roof with still joists and I'm going to blow in insulation into the cavity and let's say

I'm blowing in R-38 well there's going to be so many inches above the tresses
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where you're going to have a complete layer that's not going to have a thermal
break, but this is one application of insulation that is going to be installed in the
cavity, the software looks at that R-value that you're entering and you'd only
enter that as cavity. You would not separate out your insulation values and
assume: Yep, | know that the depth of my tresses is this depth and I'm going to
put my insulation as cavity here. I'm separating out my insulation application and
I'm going to put so much under continuous. Do not do that because you're
getting credit where credit is not due. If you have continuous insulation on this
type of assembly, the software assumes that you're doing continuous insulation
under their component, so this would go continuous foam board, so to speak,
under the filling. If you have filling insulation at the rood deck, then you have an
option to choose that from the dropdown list - Insulation Entirely Above the Deck,
and so that might be your option there. But with this one, you wouldn't break it
out, only unless that that would be the case. So if you're doing cavity and it's an
completely application, that entire R-value goes there. There's a series of
calculations on the backend of this software that are run for roofs and roofs are
pretty technical as far as it just doesn't want to run one calculation. If you want to
see what those calculations are, you can go out to our Technical Support
Document which is on energycodes.gov and it's on the Download page of
COMcheck. You can scroll the very bottom of that page and that Technical
Support Document is a link out to a PDF and it tells you every calculation that we
use in the backend of all our assumptions based - - mostly based on ASHRAE
Fundamentals and all the algorithms that are being used for everyone of these
components and how we calculate these components within the software and it
also has a appendices for every code. So if you wanted to go to a particular

code in that document, you could do that as well.
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So let's go ahead now that we've entered our roof area, let's enter an exterior
wall. So I'll go ahead and enter - - I'm going to enter a Concrete Block or let's go
Solid Concrete. Let's say it's seven inches thick. Now depending upon the
Assembly Type, it's going to ask you some more things, and one is: What is the
density of this concrete? Hopefully on your plans, you're going to know what the
density of this solid concrete and you'll choose which is applicable. These
densities come from the Appendices of 90.1. If you need more information on
the densities and what those assumptions are, you can always go to our
Technical Support and ask that question; or if you have the Code Book, you can
to the Appendices and/or the Technical Support Document also lists these out.
So there's a lot more detail depending on the components that you're entering
that if you might want to go say, "I'm not sure what lightweight means, what the
pounds per cubic feet is on that," so you might want to go out to the Technical
Support Document. There's a lot of references to some of these things in here
that you just don't see right off the top. So let's just choose lightweight and now
it's going to ask me: Well since this is a concrete exterior wall, am | don't to fur
this wall out, and am | going to install insulation. Let's say that, yes, I'm not going
to - - | am going to fur it out; I'm going to do metal framing. I'm going to calculate
up my total exterior wall area, and this is the exterior wall area that is defining the
Thermal Building Envelope, and then I'm going to put in: What am | doing? I'm
furring out the wall, so I'm definitely going to have cavity insulation. If | was to
show no furring and I'm insulating, that would go under Continuous Insulation
because there would be no thermal breaks. So I'll just enter 22 for my Cavity
Insulation and hit Okay. When | get Okay with this one, watch the U-factor

change. Now I'm at 0.120.
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So let's go ahead and enter our actual fenestration that's in this exterior wall, and
I'm just going to quickly define my Window Type, whether its tinted or not,
whether it's fixed or operable; and when you're entering your windows, if you
have in this exterior wall all your windows are the same type of construction with
the same U-factor solar heat gain, you can add them all up, and you're going to
take the rough opening. The software will calculate the window-to-wall ratio as
you're entering this information. So my exterior wall calculation up here at the
top, that's everything. | take the opaque gross square footage of my wall, that
would include any windows and doors, then you start entering your windows and
doors underneath that applicable wall, so I'll just enter 300-square feet, and I'm
going to come over and tab over to U-factor. Now if | don't the manufacturer data
in front of me, as Rose mentioned, if I'm in this cell, | can right click with my
mouse and | can go down and select default, and it has brought in the defaults
that come from 90.1 Appendices based on the assembly description | have
entered for this window. These aren't favorable, so | highly advise that when
you're entering your fenestration that you have your manufacture data in front of
you and enter that information then using defaults. But if you need to for the time
being, you can enter defaults, the same with the solar heat gain. I've clicked in
that cell and I'm active in there, so | can right click with my mouse and | can use

the default.

Projection Factor is where you're going to calculate out that overhang if you have
an overhang. If not, leave it at zero. It's not going to show up in red because this
is optional. Down under Window, let's go ahead and I'm going to enter another
exterior wall. Well, I'm looking at my dropdown list of assembly types and they
don't match my assembly; and in every one of the blue and white buttons at the

top, you're assembly components, you have the option to choose Other. If |
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choose Other, some other information goes away. | won't have the option to
enter Cavity or Continuous because now the software wants you to enter the
entire U-factor for that product. So when | enter Other here, | will total up my
square footage of that area and | have to enter the U-factor of that component.
This is something that you're going to want to back up to the code official on how
you come up with that U-factor. You want to provide your manufacturing ratings
and how you derived at that because it most likely will be questioned on how you
came up with it. Another thing that will happen is that it's going to ask you the
heat capacity. There's more information on the Heat Capacity ranges that's in

the Software Help.

Let's go ahead and go over to Basement. Now what defines a basement? A
basement, which is typically a below grade wall, when do you know it's a below
grade wall? If the wall is more than 85% below grade, then you should show it as
a basement wall if it's part of your thermal building envelope of the condition
space you're building. So with this one, I'm clicking on Basement Wall, I'm going
to define it out, let's just say it's 8-inches Solid Concrete. You're going to have the
density that's going to ask you again whether you're furring it and then you'll see
a screen that's going to come up. More information is needed when you're
dealing with below grade walls. It wants to know the wall height. I'm going to
enter 12.5-feet. It wants to the depth below grade, I'll just say it's 9.5, and I'm
going to click Okay. It also has a nice little graphic here to say, "All right, now that
you have that, how are you insulating it?" So let's hit Okay, let's go back up,
you're going to need enter your square footage. If you have different wall heights,
then you're going to have more than one basement wall component in your
project. Keep that in mind. You're going to then go over Cavity and Continuous.

If you're furring out the basement wall, which | have said | have, then | hope that
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you're entering Cavity Insulation for - - you have specified that you do have
furring. But | also might have some rigid foam board on the exterior of this
basement wall and so I'm going to identify the continuous R-value of that rigid
foam board that I'm installing as well. Then you'll see over in your Envelope that
you have two more columns that have appeared. You have the Wall Height and
Depth Below Grade. It's always advisable that when in you're in the software, you
expand that Desktop software as big as you can because the more information
you start adding into your projects, the more columns that you might start seeing

here.

Let's go over to Floor; and with Floor, as Rose touched on, Slab on Grade is one
feature that's a little bit different because all the other features you're typically
adding up the total square footage of that component, sub on grade you're not.
But when do you enter a slab on grade? If you have an exposed edge of slab
that's part of that building envelope, your Condition Building Envelope, you're
going to show it and it goes - - and you would enter it in linear feet. What defines
the depth of when it's not required to show a slab on grade that's part of that
building envelope? If your slab is greater than 24 inches below grade and you're
showing your basement walls as part of that condition to building, you would now
show a floor component and the software will assume you have a below grade
basement with a slab that would not be applicable to any insulation levels that is
more than 24 inches below grade. If that slab is less than 24 inches below grade,
part of that building envelope, then you would need to enter it and show it.
Regardless of whether you're insulating it or not, it's part of the building envelope
and you should define it as part of your project. You have the option of unheated
and heated here. Heated means you've got some sort of hydronic heating

system within the floor, insulation requirements will be increased for heated
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slabs. Let's just show Unheated. You will get a screen that will come up
regardless of whether you show Heated or Unheated, and it's going to give you
some graphics to say, "How are you insulating the slab, and what's the insulation
depth?" To define the insulation depth and how you are going to insulate it, your
Construction Details button at the top here needs to be clicked. | can show
Specify No Insulation, Horizontal With Vertical and you'll get a dropdown list of
depth of insulation, Horizontal without Vertical or Vertical. I'll just click on Vertical
and I'l move my mouse over and I'm going to say 2-feet. Then down at the
bottom of this graphic here, I'm going to click Okay. Then | go back over to my
grid and I'm highlighted on the Floor, the Slab-on-Grade Unheated, look over in
the Gross Area column and beside that you don't see square feet anymore, you'll
see feet. Now you would enter the slab-on-grade in linear feet. This is the
exposed edge that defines that condition part of the building. | specified when |
was in the other screen that I'm showing 2-feet of insulation. Don't forget, and it
gives you a little popup to not forget, linear feet and to add and enter your
continuous insulation R-value that you're proposing to install on that slab, so I'll

just go ahead and enter ten.

Now with that, these are just some of the main assembly components that we
know that's brought confusion, but you would go and enter your entire building
envelope within the Envelope, and I'm going to open a data file and we'll play
around with a little bit more, but these are just some of the ones that actually
have a little more features and some more pop ups that you want to make sure

you're getting all your inputs in there appropriately.

So let's go ahead and let's jump over to the Interior Lighting; and with this one,

you're seeing that | have some Building Occupancy Types in here. | have Retail
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Sales and Parking. These are the two things that | entered over in the Project
tab for my Building Use Applications space-by-space; and | can take right after
the Component column, my little Arrow button here and expand this if | want to
see that Component Description a little bit more, so | can expand my columns.
Now how do | start entering this information into my lighting? | have to highlight
the space that | want to start defining all my lighting fixtures in, and let's go ahead
and let's enter a lighting fixture. I'm just going to choose Incandescent, 75-watt.
Each one of these Lighting Fixture Component Assemblies up here has a
dropdown list. | will show (inaudible) one, I'll enter four. I'm going to enter, let's
say maybe | don't know my fixture wattage. Now this is dependent upon the
actual lighting fixture that you have chosen, but some of them do have default
wattages. So if I'm in there, | can right click and use Default. This one's pretty

straightforward because it is an incandescent so it's going to come in at 75 watts.

With that, maybe | have some sort of an exemption or allowance. Now when |
went into the Lighting tab, this column, the Exemption Allowance column,
automatically appeared for me. | did not have to go up to Options and click, Yes,
| want to see the Interior Lighting Exemption Allowance column to appear in my
grid. It already did that because | chose that in my Preference to come every
time. So if | was looking at this retail sales area and | have an allowance that |
need to show, I'm going to click on the dropdown Arrow button, | will go to
Allowances. Exemptions has a list of exemptions that you could define as well,
you can come over to Allowance. I'm going to say it's Retail Fine Merchandising;
and with that, another screen will appear, and this is dependent on what
allowance that you're actually going to show, | need to define where that retalil
display lighting is based on the area of that retail display (It could be a Retalil

Display Cabinet. It could be a Wall area) and enter what the area is of that
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allowance. When | do this, if you look up where it says Allowed Wattage and
Proposed Wattage, it's going to add that allowance to my calculation. If this was
an exemption up where you see Allowed versus Proposed, it's not going to add it
to my Proposed. It would not show it because it wouldn't be going against my
proposed wattage for what I'm entering here. So you want to pay attention to
when you're going to through and entering your lighting fixtures the calculations

that are happening here.

Let's go ahead and go over to Exterior Lighting. Now | can go ahead and start
entering my exterior lighting and | could click on the Linear Fluorescent and so
forth, but I'm clicking on it and here's something that sometimes happens to
users, nothing's happening. If you look down below in the Component
Description and it's giving you a little note here to say Invalid Exterior Use Type.
And why is that? Well over in the Project tab, | didn't define any exterior lighting
areas; and until | define exterior lighting areas that can be automatically brought
over to my Exterior Lighting tab, | can't start defining the fixtures that would go
under that exterior lighting. So you want to make sure that you are defining it
over in your Project tab first, or you're just going to have to go back over there
and do so. I'll just quickly enter one and then we'll go back over to Exterior
Lighting and you'll see that now that | do have that application and | can go
ahead and start entering my actual lighting fixtures that would go under that

application.

Another thing to note here is the last column is Fixture Wattage. Where's that
Allowance and Exemption option? Well you don't see it here. You got to go over
to Options and you have to click on Exterior Lighting Exemptions. Now | have

that extra column, so if | do have some exemptions that might apply to some of
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my lighting applications as I'm defining out my lighting applications, | can show

them based on the exemption list based on the code that you're on.

Let's jump over to Mechanical. With Mechanical, this is not a pass or fail, | can
customize all my Systems, my Plant, my Water Heating. Based on those inputs,
it will provide a customized list of requirements and that list can grow and grow
depending on how complex your system and your plant and your water heating
systems are; and | highly advise not only would you want to submit that to your
building department, print these out for yourself and go over them and make sure
that you are meeting those. If those are ones that not applicable to your project,
make sure you note that to your plan reviewer that it's not applicable. It's going to
pull all of the requirements from the code that you're on into these reports, so
you'll want to pay attention to these reports, and we'll take a look at those after
we play around. So | can click on the HVAC system up here at the top, the Plant,
the Water Heating, and it's going to provide screens. These screens will continue
on and on based upon how detailed your system is. So if | was to put in a Central
Furnace and | come over to my Cooling Equipment and | say it's a Filled
Assembly DX system, I'll come down to Zoning. | can define my zoning, Single,
Multiple, or Perimeter. I'll leave it at Single, and I'm going to hit Okay. It's going
to bring that into my grid. It wants to ask me, and it's in red meaning | need this
information before | can actually create anything that will show up on a report, |
have to define out my Equipment Capacity. | need to enter my Fuel Type Heat
Source. | came down to my Filled Assembly DX System and again Equipment
Capacity needs to be defined and my Condenser Type needs to be defined, and
you can go on and on down through the list with your Mechanical System and
define the quantity. Maybe | have more than one of these. | can actually click on

my HVAC system, | can double click in Column 1 and maybe | want to give this a
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little bit more information to what this really is. | want this to show up on my
report because as the plan reviewer's looking at this report, he's probably looking
at my mechanical specs, and my mechanical specs shows this as an R-1/R-2,
and it's just going to be easier for him if this shows up on the report to go find it
on my specs, so | can double click in there and change that. Over in Plant, | can
enter my Boiler Type, my Cooling Plant Type, and hit Okay. Again, you're going
to see more information for Equipment Capacity, the Fuel Type, Condenser. It
provides another piece of information, which is your System Detail, so I'll go
ahead and enter some Fuel Type; and over in System Details, it's going to ask,
since I've entered Hot Water for My Plant, what type is this? We'll put 2-pipe
Changeover System in hit Okay. The Condensing Unit Type is the same thing.
You need to enter the capacities of the condenser as well. So let's go over to
Water Heating and let’s just say it's a storage water heater. Now this is optional,
if you don’t want to show your water heating you don't have to. This all depends
on what you want to show to that plan reviewer to make it easier for him when
he’s going through your plans to show up on the report. With me entering the
Storage Water Heater, | can click where it said 60 gallons. | can change that. |
can change it to 80. | can select the Fuel-Type Source, we'll say it's Gas and
then my systems details for my storage water heater, let's say | have a heat trace
(I can’t talk hardly) a heat trace tape installed on the system and I'm going to hit
that and click that as my option, and the input rating, check what you have for
your water heating systems to make sure that you're changing that if the Btus are
not 75k. If that's the case, click on that box and change it to what is applicable to

your water heating storage system.

Now that we've just briefly touched on how you enter your components for your

envelope, Interior and Exterior and Mechanical, let's go back over to the Project
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tab before | open up an actual project, | want to show you a completely different
feature which is called Alterations. Alterations is an option that's only available
for the 90.1 Code Options. Alterations means that | have an existing building that
I’'m renovating, it's conditioned and maybe I'm replacing the roof, maybe I'm
replacing windows, furring out some walls that's part of the exterior building
envelope; | have some spaces that I'm going to replace lighting in, and I'm
replacing some mechanical systems. That would be considered an alteration.
With that, when you click on Alterations from the Project Tab, it's going to give
you some descriptions of what an alteration is, what an addition is to make sure
that when you go down this path you know that alterations is a separate
calculation feature with in COMcheck. You can't switch in between Alterations
and New Construction and think it's going to save your data. It's not. As I've
entered information in the Envelope tab, watch what happens. So | will hit: Yes
I'm fine, | read that information, | have Alterations clicked as far as my Project
Type, more information will appear as far as Space Conditioning Type. It's going
to ask you the non-residential, residential, and semi-heated. Project details,

we've already discussed that.

Now Area Category, you don't see Whole Building Type because Area Category
is for lighting only. You don’t have to enter your area category spaces if you are
not doing a lighting alteration. It wouldn’t apply. That's only for lighting and
lighting for an alteration is on a space-by-space basis. Lighting is applicable if
you're replacing more than 50% of your luminaires within a space, or you've
increased the wattage of that space regardless of if there's existing and or new.
Under Exterior Lighting, you'll see that that's an option as well to show your

exterior lighting.
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So with the alterations, | go over to the envelope and all that information - -
because | never went up to the Tool Bar and clicked New, but | went over to the
Project and | clicked Alterations, all that component information that | was
entering as a new construction disappeared. Reason being, alterations, every
component is standalone. When you're doing an alteration, it's prescriptive. If |
show a roof component and let’s just define it the same description as | had for
the other one, attic roof is still joist, it will give you a series of exemptions that
might apply to my alteration; but if | have no exemptions, and you can read
through these as you're doing your alterations because they do change
depending on the component. But if you say, “no,” each one of the components
that you're dealing with as an alteration, the software will give you those
compliance requirements to make this a little bit easier for you. It's pulling from
the actual code that you're on, the 90.1, it'll pull that maximum U- factor; it will
give you a possible what you need to insulate it to to meet that maximum U-
factor if applicable, that will help you. So with this one for the roof, | have no
exemptions; it's telling me what | need to meet to meet that maximum U-factor,
and I'm going to hit Okay. You're seeing some different things with an alteration
as far as your columns; you see a Post Alteration Assembly with a type after your
component, you're going to see Alteration Details as a column within your grid.
Each component that you’re touching within that Exterior Building Envelope must
pass on its own. If one of the components does not pass and you're identifying it
within this grid, down at the very bottom it will just say Envelope Fails. It doesn’t
mean envelope fails for the entire alteration project, it means you have to come
back up and find which component was failing when you were entering these and
make sure you bring it up into compliance. You could have three other ones in
here that pass, but you need to pay attention to that because it's not an overall

every building component you put in here and it's calculating a total percentage
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pass or fall, this is individual now. This is very prescriptive. So over - - if you go
from the Alterations Details where it says Compliance Is Required, | haven't
entered any cavity or continuous information and my proposed U-factor is
showing up in red. As we know, red’s bad. We have to meet that maximum U-
factor of a 0.027 for this roof to even quality to meet code as an alteration. So
again, I'm going to have to enter what I'm proposing to install in this roof
alteration. Again, this is dependent. So I've already entered cavity of 22, but that
really doesn’t get me there. It's recalculating my proposed U-factor, but | need to
do a lot more to this roof structure to even get it into compliance. So if | even put
38 in there, I'm still not meeting it. This is something that you'll have to work
through with your actual building plans when you’re doing your alterations. I'm
not going to go into a lot of detail of the actual calculations because this is
COMcheck Basics; but if you're into alterations and you have detailed questions

based on the code, you can always send a question in to Tech Support.

The other buttons in this alteration outside of roof, work about the same way. If
you're replacing windows, it wants the pre and post information for that. If you
have windows that you're replacing, it's going to ask you what the U-factor and
solar heat gain is of the windows that were in that building. Well if this building’s
20 years old, you probably don't know what those U-factor and solar heat gain
coefficients are, but you have the option again to use those defaults so you can
right click with your mouse and define the existing windows and doors within that
building using the defaults. You don't want to use that for the windows that
you're putting in, but you can show it up for the actual windows that were existing

in that building.
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The Interior Lighting, again this is where for an alteration typically works the
same as if you were defining new construction, but alterations is space-by-space
only. So if you wanted to show your lighting separately and you're going to redo
all the lighting, then you don’t have to show it as an alteration if you don’t want to.
You can show it as new construction. Calculations are the same and your

exemptions and your allowances will come up based upon the code itself as well.

So now that we've gone over the alterations, we've gone a little bit over new
construction and how you enter your project information as far as the envelope
Interior, Exterior, and Mechanical; let's go ahead and open up a data file and let’s
play around with this a little bit. So I'm going to go to File and Open; I'm not
saving anything to this document that | was playing around with, and it actually
takes me to where | have a saved file in my actual data location and I'm going to
click on it and I'm going to hit Open. Now this project, the code is again - - you
can look at the Title Bar at the top, 90.1 2004 is the code that this project is
showing compliance to, my Project Location. This is New Construction. Project
Detall Information has been entered. Building Use, then space-by-space, and |
have several different types of spaces in here that have been identified as my
Project and down on Exterior Lighting, and look at the Exterior Lighting; look at
the quantities and look at the units and the tradable versus non-tradable, and
we’re going to talk about this when | get over there to the - - because this is a
populated project that we're working with, how the calculations are working for
those areas. Let's go over to the envelope and take a look at what we have.
Now this project's a completed project. Down at the bottom, this envelope
project passes by plus 6%. If we're up here and we're looking under Roof, and |
have my Cavity and No Continuous Insulation and | have one wall component,

what this means is that this project here doesn’'t mean it has one wall, it means
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that every one of those exterior walls have the same assembly construction and
the designer totaled up all those exterior walls and entered it as one line item,
which is kind of nice. It makes the compliance report smaller, don't have as
many components that you have to review as a plan reviewer, and then all the
windows and doors that are applicable within those walls have been entered

underneath it.

But what if | want to define out my exterior walls and show orientation? This is
where | would add another exterior wall, and we’ll show this Solid Concrete, 8
inches; we’ll show Lightweight, Furring Metal, same thing that I've done before,
and I'm going to enter the square footage of this exterior wall, 22 cavity. I've
entered this exterior wall; with that, I'd have to subtract that area from Line Item
Number Three if I'm going to actually decide that | want to show orientation and
separate out these walls for this project. So I'm going to have to subtract and
show 5,000 square feet instead of 6,000. Now I've got all these windows and
doors here. Well since I've added another exterior wall, | need to make sure that
| have the applicable windows and doors that are in that wall underneath that
wall. The software does a child-parent relationship and it's going to look at what
you have for fenestration under these walls, especially when you're dealing with
orientation. So let's just say this door here, that's part of that exterior wall. What
I've done is I've highlighted it and I’'m holding down with my mouse with the left-
hand button and | can move that, highlight that exterior wall, and you'll see on
line item ten I've highlighted it, and | let go with my mouse and it will drop that
door underneath that exterior wall. So it's a nice little feature that you can move
your components around. Some components can’'t be moved around based on
what you’re doing; but if | had these windows and doors that | know weren'’t part

of that exterior one wall, | can push - - hold down the mouse button and move it
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under that wall. Now | said | wanted to show orientation, but | don’t see a column
to even specify orientation. | need to go up to Options, and this is where you
have the Comments and Description and the Orientation. Now if | were to
specify this under Preferences, it would have automatically been showing in my
grid down below, but | didn't specify it. If this is something that you want
specified every time, then you would do that in the preferences. But here | can
click on Orientation, and | did so. That brings another column into my grid and
now | have an Orientation column right after Component. This is where I'm
looking at exterior wall one and I'm going to specify my orientation on that wall,
northeast, South, whatever it might be. Exterior wall, two same thing. Now you
would probably have more than two walls here, this is just to briefly show you
how the orientation does work and how you can get that option. Let’'s go back up
to Options and let's click on Comments and Descriptions. This is again you need
to scroll with your scroll bar if you can’'t see the comments and descriptions on
your screen, but it brings another column to the very end; and if | have some
unigque type of system for a component that | want to show up on my report, then
| can type that information in there. It's very optional, and it'll show up on that

Compliance Report for the plan reviewer.

Let's go over to Interior Lighting, and let's take a look at this. We have several
applications here. There’s several Space Types that are already defined. | can
click on Column One on that component and | can minimize all those lighting
fixtures if | want to. If | have a lot in here | just - - I'm working in one space at the
moment, | can minimize or | can click again and then | can see all the actual
fixtures that are underneath that space type. So let's go ahead and let's look at
this project and say, “You know what? | looked at my lighting specs and I'm

missing some information here." Maybe I’'m missing some LED Under Shelf Task
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Lighting that would be in the Office, so I'm going to move this component
description over to make sure I'm going to enter this LED lighting fixture in the
right space category and so I'm going to enter this task lighting Under Shelf Task
Lighting under my Office Enclosed. So I'm highlighted on my Common Space
Type For Enclosed, and I'm going to go up and with LED, LED is not an option to
choose from from any one of these; the Linear, Compact, HID. How you would
go about entering an LED is | would advise chose HID, with again you're going to
go to dropdown list of choices, chose Other. With Other, it automatically brings
in the ballasts of standard because with an LED, of course you’re not going to
define out a ballast. LEDs are emerging technology. Lamp choices and
applications, they’re not uniform enough for us to actually incorporate in the
COMcheck in the tool at this point; and as far as ballast, you don’t want to define
that because of the reason of the LED being driven by individual diodes. So with
that said, then Lamps Per Fixture again with an LED, it would be one, and then
you would be specifying out the actual fixtures for that number in which I'm going

to show 14 and the Fixture Wattage of 18.

Again over here under the component, it's saying it's an HID. | can double click
here and change that description. | can come over to the Fixture Description and
| definitely want to put in what that is which is an LED Under Shelf Task Light.
So I'm typing that in there; and with that, maybe there’'s some exemption or
allowance. | don't think there would be with this type of application, so we won't

put anything; we’ll just leave that at none.

Let's go down to the bottom space type down here for Lobby, and | have the last
line item here, which is Line Item 17, and the Chandelier is what this space type

is. The Fixture Description has already been entered. Let's come over to the
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last column where it says an Exemption and Allowance. This chandelier is
decorative and so of course decorative has been shown as the Allowance,
Decorative Appearance, and what it's going to ask you is the same thing as when
| was talking to you before about retail display. It wants to know the square feet
for where that chandelier is placed and so chandeliers are kind of tricky. You're
going to be making your best judgment of the floor area of where those
chandeliers are placed because those are not specific to an actual lighting task
so you do get an allowance for those, and then you would define it what the

square feet is of that area and here we have 600.

With that, let's say that our project is okay now. I've entered my LED Lighting
that | didn't have before because | was looking at my lighting specs and | needed
to make sure | entered that. My lighting still passes, my Interior Lighting down
below says Plus One, and I've defined out any Allowances. Line item 17, | got
the chandelier defined as my Allowance as Decorative, and I'm good. I've made

sure all my information is correct, so let’'s move over to the Exterior Lighting.

Again, this is already pre populated. If | look at the Exterior Lighting, as I'd
mentioned before, we have several applications under Parking. You'll see that
beside that it says Tradable Wattage. It gives you the Allowed and Proposed.
This one’s actually under. | am at 4,793, so the additional or | would say the
leftover could be used in another area or another application that would be
tradable, such as the walkway. Because with the walkway, my proposed is 268
and I'm over what would be allowed, but it's tradable. So in between those two
applications there, if those where the only two I'm showing for this project, they
still might meet code because I'm trading in between them. Non-tradable, the

next one down, that's a use or lose it. So whatever the case may be, the non-
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tradable, you're using or losing it and there would be no trading in between other

applications for it.

So let's take look at the ATM Lighting down here, and let’s say I've looked at my
lighting specifications and | missed that when they’re installing this, these ATM
machines, there’s going to be the same lighting but it's temporary lighting.
Regardless of whether it's temporary lighting, it still must be shown as part of
your compliance. Let’s just assume that it's the same amount of lighting fixture,
same description as what's under this ATM. So I'm going to highlight Row 15
and I'm going to go up to my Tool Bar and | want to go Duplicate Row. So |
clicked on the Dual Duplicate Tool Bar button and it brought down that same
amount of fixtures from line - - the line below the ATM underneath it. It says
Copy One; | might want to change that because | don't want Copy One to show
up on my report, so | can double click in that cell and delete Copy One and leave

it at the HID, maybe I'll change it to four.

Now let's go over and take a look at; hmmm, | said it was Temporary Lighting,
this is temporary so is there an exemption for this lighting? So I'm going to click
on the button over here and see if there's an exemption for temporary lighting
and there is so I'm going to choose it. When | did that, because if | would have
duplicated this, this project would have been failing, that this temporary lighting
sets an exemption it did not add to my overall proposed calculation. So now that
I've defined it, plan reviewers fine, he knows it's temporary, shows it as an
exemption because | want it to show up on my report, my exterior lighting still
passes. Not very great, I'm only passing by 0%, but | have defined out all my

applications and the lighting that is within them.
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So with that, let's just jump over to Mechanical really quick; this is populated.
This is pretty easy because you can customize through your HVAC system,
Plant, and Water Heating and as | was showing, you the mechanical when we
were just going through and looking at entering the information, this R2/R3 that is
defined by you by double clicking in there and putting that information in, which is
optional, then it can match the actual mechanical specs on your report. You

won'’t see the Pass or Fail down here at the bottom.

So with that let's go take a look at some of these reports. I'm going to go up to
File and View Print Reports. | always advise before you go print your reports,
save that data file first, so you would click Save. You can save your report as
well and then go view them, that way you're for sure not to lose any data. So
let's go Look At View Reports. Within that, you can select some of the reports
that you want to see. | can unclick on these, but | want to see all these at this
point, so I'm going to hit Okay and leave them all clicked. This is the Envelope
Compliance Certificate. Rose went over some of the things that you'll see on
here which is your Project Information, the general information that will provide
the heating and cooling degree days that you would have not have seen when
you were in the Project tab, so you want to pay attention to some of the
information that shows up on these reports that you did not see when you were
entering your data, and I’'m going to go over some of that real quickly. So I'm
scrolling down and all of the envelope components that were entered in this data
file will show up on the report; Cavity Continuous Insulation. But with that there’s
another column that you didn’t see on your report and it's the column over here
called the U-factor. What I'm doing with people on Tech Support, designers that
they've sent me their data file and I'm reviewing it with them and they don’t

understand why their project’s not passing, they want to make sure it does, they
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don't understand what component would get them there. Go to View Print
Reports, pull up the report, even though it's still failing at this point, look at the
Budget U-factor column. These provide you what you proposed and what the
Budget U-factor is to give you a very quick idea of what components are your
high hitters that are causing that building envelope to fail; and with that, you will
go through and look at those Budget U-factors. We're not going to go through
these since this is COMcheck Basics, but this gives you a really good idea when
you're problems with passing. Go look at the reports first and be looking at the

proposed U-factor Budget and U-factor columns on that report.

Let's scroll down a little bit more. With the Envelope Compliance Report, the
other features that will be added to it are the Mandatory Requirements. You
have insulation; you have fenestration on the doors. Let's move down a little bit
more, you will see from the code that you are showing compliance to, Leakage
Component Certification Requirements and then down at the very bottom, of
course, your signature. Now if you're emailing your reports in electronically,
maybe you have an electronic signature with the building department or you
need to deal with the building department as far as how you're going to go about

doing those signatures if you're sending them in electronically.

Let's scroll down a little bit more now. Let's go the Interior Lighting. There’s two
reports that come up. There’s the Compliance Certificate and then a Worksheet.
On the Compliance Certificate, you've got the basic information again. In Section
2, this is where you'll have all those activity types and their square footages.
Section 3 is the Requirement Checklist. It's going to have the Allowed Watts, the
Proposed and whether the project complies, and then it starts going in to the

mandatory requirements, your Control, Switching and Wiring. These are things
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that are going to be inspected when the inspector goes out in the field and make
sure you’re complying. Controls are big and you want to make sure you have on
your lighting specifications what you're doing with your controls and switching.
This just provides the mandatory requirements of what is required based upon
what you're doing so there might be some exemptions if you're doing occupancy

sensors and so forth, so pay attention to this area.

Scroll down a little bit more, let's do this real quickly. The Voltage Drop, if you
have feeder conductors, the maximum voltage drop of 2%, those are code-driven
again. And then down a little bit further is Actual Compliance Statement; and as
you'll see on here, the name, title, and signature, name/title is blank. Now if |
was to put in preferences under lighting, my name, it would show up on these
reports every time, so it's just a nice feature to customize these reports a little bit
more to the designer or to whoever he wants to have on that report. And then
your Post Construction Compliance Statement providing those drawing,

operating manuals, and so forth.

Down a little bit further is the actual Interior Lighting Worksheet that I'd
mentioned. This gets into more detail, and | will mention just a few items here
that we were playing around with in the software. I'm going through and I'm
looking through my calculations. But as a reviewer, if there are any allowances,
and I'm highlighting that last row which was the Lobby and it was 600-square feet
for that decorative appearance, it doesn't say what that decorative appearance
here in this calculation is, but it will down below. But you want to pay attention to
anything that's defined out as an exemption or allowance and make sure that
when they've defined it, they've calculated it correctly, and the floor area or the

area of that allowance or exemption has been done correctly.
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So if we scroll down a little bit more under the actual Lighting Calculations and |
will just pull out where that decorative lighting is, you'll see under the Comment
Space Types for that lobby that here’s that chandelier that was defined as
decorative. You have the Compliance Calculations down here on the right-hand

side; the total watts, proposed watts, and whether it complies.

Now let's jump over the page where it's Exterior Lighting. Same thing, project
information, you've got your lighting, exterior lighting applications and
calculations; make sure you briefly go over your quantities and that you've
defined out your quantities and units properly. We’'ll scroll down a little bit more;
Exterior Lighting Fixtures and again this is everything that has came over from all
the information that you've entered in your Exterior Lighting grid, and we’ll come
down to the Requirement Checklist for the Exterior Lighting and another one, just
to mention, is those controls, switching, and wiring, and then the exterior lighting
efficacy which is based on exterior lighting and code-driven (inaudible) as well

itself, and then of course the compliance statement.

Now Mechanical, we could talk on mechanical for days depending on how
complex the systems are, and this is just a project that was entered to provide
the information based on the actual HVAC system, Plant, and Water Heating
system that was entered in the project that | showed you. It will show you the
general information, the Mechanical Systems List, and you'll get those briefly.
Then down below, it will separate out all of those systems and provide the
requirements that would be applicable to the system entered underneath each
one of them. You'll want to look at these and make sure that either that's

applicable to your project or not and note it on here. Doesn’'t mean every one of
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them are because when you get into mechanical, there might be some things
that are not applicable; but to make it easier for the plan reviewer, note it before

you submit the paperwork.

Load Calculations, can’'t do those within COMcheck because it's not a load
calculations type of software application, but here it sits to say It's Required and
you need to submit separately and so on. There's several different other things
that are in here, you've got your piping insulation, duct design, duct insulation,
and so forth, and you read through your list and make sure everything's
applicable. At the ending here is where your Compliance Statement is and your

post-construction and compliance as far as signatures and so forth.

Well that's just a quick overview of the basics of COMcheck; and again if you
have questions on that, you can send them into our Tech Support, and I'm going

to move it back over to - - I'm going to move it back over on to Rose.

Alright. Thanks, Pam. The U.S. Department of Energy wants to thank all of you
for your attendance today; and before we begin answering as many of the
guestions that have come in as possible, | want to put up the link where you can
complete an evaluation and provide us with your AIA information or print a
Certificate of Completion. You’'ll need to write down this link and type this link

into your browser in order to do that.

Now for the questions, we each have several that have come in. I'll give Pam
her stack. | do want to let you know that if we do not get a chance to answer
your question live before we have to end the webcast you will be receiving an

email answer from us within the next week or so, so you will get an answer if we
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don't get to it here during the webcast. So I'll start off | think. | had one question
that came in during my presentation related to whether COMcheck can handle
semi-heated spaces, and | think Pam addressed that during the software demo
that: Yes, there is a Semi-Heated checkbox on that Project screen under the
Applicable 90.1 Standards. So if that's the standard you have to use, then you'll
see that Semi-Heated checkbox and you'll want to mark that as appropriate; and

if you have any questions, you can check the Help System.

Had a question come in about an example of an exempt interior lighting fixture,
and again this is based on the code that's been selected, but a couple of
examples would be: Museum Exhibit Lighting can be exempt under certain

codes and Emergency Lighting is also exempt.

Had a question come in about the allowed wattage versus proposed wattage
criteria for compliance and whether that's based on whole building or space-by-
space. It's based on whatever you selected on the Project screen under that
Building Use, whatever building use types you entered is what the allowed

wattage is based on.

Is it possible to use just a portion of the software, for example, just lighting? Yes,
each of the building systems comply on their own. As you saw, we have the
different compliance indices on the screen for Envelope, Interior Lighting, and
Exterior Lighting, so you can use the software for any one of those separately.

Pam, you have several too, so I'll let you answer a few.

Okay. One of the questions was: How can LED compliance be achieved with

COMcheck? COMcheck cannot be used to show compliance to LED. LED has
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their own specifications. LED is based on actually 90.1 Appendix G, which is
performance based, and there are software applications that can show
compliance for LED and there is an actual URL out to the building technology
software directory that will take you to all those whole building performance
applications do that such as Equest*, Energy Plus*, and those type of ones. If
you are interested and you need that URL and you cannot find it, we have not
displayed it here on the screen, but send me in an email through Tech Support

and you can get to that through energycodes.gov and I'll send you that link.

Another question is: An office within a warehouse separated by an acoustical
ceiling, is that allowed with insulation on top as separation of an air conditioned
space? Dropdown ceilings that are not completely sealed but would separate an
unconditioned area from such as an office space, would not be part of the
building envelope; and regardless of whether you're putting - - you're throwing in
batt insulation up in that dropdown ceiling, that would not be considered the
ceiling that would define the conditioned office space. You'd have to look at the
roof deck and you're going to have to make sure that that roof deck, you're going
to have a thermal break that would separate that unconditioned warehouse from
the office, so this has been a question that comes up quite a bit. We do have a
FAQ out in the Resource Center. If you go out to energycodes.gov, there's a link
right to the Resource Center which goes through a series of graphics and FAQs,
code notes, and so forth. If you were just to search on acoustical or dropdown

ceilings, you're going to find more detailed information on that.

Next question: Is the P.E. who signed the mechanical drawings responsible for
signing the mechanical? Does the P.E. or registered architect need to sign the

compliance forms for - - in COMcheck? The code has one stipulation and does
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not provide a lot of specifics for commercial buildings, and that is that
Compliance Reports that are submitted, whether Envelope, Lighting, Mechanical,
it must be done by a registered design professional. That's it. What does that
mean? That means that typically it's a registered design professional that is

registered within the location or the state of which they are submitting the project.

Another question: Is compliance required in an existing building where a change
in tenants or a change in occupancy is proposed or will occur? This is another
guestion that comes up quite a bit. If you have an existing building that is
conditioned and it was occupied, let’s say it was an office and they’re going in to
renovate this and it's going to become a retail space, that's a change in
occupancy. Does that mean that building has to comply if you're not touching the
building envelope? More likely, you're doing lighting so more than likely you'd
have to show lighting compliance for something of this nature. But the code - -
and this is around... | mean all the baseline of all the codes for change of
occupancy is if you're increasing the energy usage of that building based on the
change of occupancy, then it must show compliance to the code applicable at
that time. But if it doesn't, your plan reviewer still might request from you that
you document and you show since you've changed the occupancy of this
building that it does not increase the energy usage, so there’'s the exemption
there. If this was an unconditioned building, such as a shell building that will now
be rented out and now you're going to have tenant spaces and it will be
occupied, then that shell building or spaces that are within that building would

need to comply to the code that's applicable in that location.

Rose, did you have a couple?

55



Frss

COMcheck Basics

Building Energy Codes

Rosemarie Bartlett:

| do. One that was a very good question that we didn't even refer to was: When
will the 2009 IECC will be available in COMcheck? So thank you so much for
reminding us to speak to that. We are working as hard as we can to get the
2009 implemented as fast as we can, but it absolutely will be in the software by
the end of September. We're hoping for the summer, but our absolute deadline

for it is September, so thanks for sending that one in.

Let me see, we have several that are coming in even as we're answering these
guestions so bear with us as we’re sorting through. Another one | had was:
When submitting the type of construction, addition, or alteration, is there a choice
for a combination of addition and alteration? And there is not. As you saw in
Pam'’s software demonstration you - - if you have both an addition project and an
alteration, you'd have to have two COMcheck projects, one for the addition and

one for the alteration.

Another question was : Is it possible to pass individual tab information to another
individual, for example, one person is showing compliance for lighting and
another for envelope, another for mechanical? Couple ways you could do that,
one way | suppose is if you were doing it in sequential order, you could have
someone start the project, complete their tab, their Envelope tab or what have
you, save that project and send it along to the next person to do lighting, or
another option for you would be to use COMcheck-Web; and if everyone has
access to the same project saved on our servers, then you could do it that as

well.

Another question was: Is it okay to write in the Note section, the design and the

manufacturer of the thermal insulation system for the building? Certainly. That
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Note section is for use and so whatever information that you fee would be
valuable for you to have to differentiate this project from another; or if on the
other hand you want to put some information in that are helpful to the code

official, then that's great.

When would you use the Interior Wall category in the Envelope tab? The Interior
Wall Component button is only available under certain codes, and you would use
that one example | think | gave in my presentation was if you have an office
space that's conditioned that's within a warehouse, you could use the interior wall
to denote the interior walls of the office because it's not separating it from - - it's
not an exterior wall, but it is separating condition space from unconditioned

space. If you have further questions on that, you can go to the Software Help.

Okay, Pam.

Okay. Question on: How do you handle existing interior lighting fixtures for a
remodel? These fixtures to remain as is. Do you need to input them into
COMcheck? First, you'll need to look at: If this is going to be a remodel, is it
space-by-space when you're looking at this as an alteration? Are you replacing
more than 50% of the luminaires within the space; and/or if not, are you
increasing the wattage? These are two things that would bring you, that would
have to bring you into compliance if more than 50% or you're increasing the
wattage. So with that, and you're going to leave some existing lighting within that
space and you need to comply, you would show the existing and the new for that
space in its entirety, and it might even be that the plan reviewer wants to see that
that space meets compliance anyway. So if - - even if you have the criteria that

you've decreased the wattage and it's not 50%, he still might want to see it, that's
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up to his discretion, but you would show both. So you're going to define out the

entire space, whether you have old and new.

Another one is: If we use choose the Orientation Option, are there benefits or
disadvantages? Well there's both because if you don't choose Orientation and
specify out all those walls and put the appropriate fenestration under those walls,
of course there is. You're now doing it by orientation and so if you're having a lot
of fenestration on some certain areas of the walls, that can actually hurt you if
you're solar heat gains on those windows are not that good in a location where it
might require that the solar heat gain very low and that that could actually hurt
your project. If you don't define Orientation, then the software makes an
assumption for all the walls based on like an eight quadrant orientation. There's
more details on the calculations and logarithms of the orientation for the
assumptions if you're not going to show them and define them out in that
Technical Support Document; or if you more detailed questions, again send it in

through Tech Support and we can discuss it further.

Rose, it's almost - - we're just about done with the webcast. Did you have a few

to final up on?

No, | think I've handled all the ones that we probably have time for, Pam. We're
just about out of time. So | think what'll do is we'll assembly all of the rest of the
guestions that we didn't get a chance to answer and those that have just been
coming in as we've been answering questions and, as | said, we'll get responses

out to all of you via email in the next week or so.
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So we'd like to thank you for participating in today's webcast brought to you by
the U.S. Department of Energy's Building Energy Codes Program. You may all

disconnect.

Please Note:  * Proper names/organizations spelling not verified.
[sic] Verbatim, might need confirmation.
- - Indicates hesitation, faltering speech, or stammering.
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